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Eagle Point Solution to a Frequently Asked Question

How to Model Stream Improvements Using RoadCalc, Surface Modeling, and Water Surface Profiling

Summary:

Through the use of the RoadCalc, Surface Modeling and Water Surface profiling modules, you can easily model stream
improvements. The general procedure involves modeling the proposed channel using RoadCalc. Once the channel has been
modeled, you then create a surface model of the proposed channel. Water Surface Profiling is then finally used to extract the cross-
sections along the proposed channel and then send that information to HEC-RAS for processing.

Product: Eagle Point Software™ 2001
Release: 2001 and greater

Platform: All

Related documents:

The tips, solutions and suggestions contained in Eagle Point Solution Papers, any Eagle Point Technical Assistance Document or
given by an Eagle Point Technical Assistance Representative are suggested for use at your own risk. Document contents are
subject to change without notice. No warranty of any kind, expressed or implied, is made with respect to such tips, solutions, and
suggestions except as may be expressly stated in the licensing agreement or other contractual document, including, without
limitation, any warranty of merchantability of fitness for a particular purpose. In no event is Eagle Point Software Corporation liable
for incidental or consequential damages in connection with or arising out of the use of such tips, solutions and suggestions.

AutoCAD is a registered trademark of Autodesk, Inc. MicroStation is a registered trademark of Bentley Systems, Inc. All other
product names are trademarks of their respective holders.

As always, should you have any questions regarding any phase of installation, contact Eagle Point Technical Assistance at
(800) 477-0909.

CREATING THE PROPOSED CHANNEL
The first step to modeling the channel reconstruction is to create a RoadCalc sub-project. Below are the steps to do that.

1. From the Eagle Point Menu, select File » New. The New dialog box will appear as shown below.
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2. From the list of items select RoadCalc Sub-project. After making the selection, pick on the Next button. The RoadCalc
Subproject dialog box below will appear.
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3. Enter the Sub-project Number that you want to use. Eagle Point will automatically increment the number for you if you want.
Enter a unique description for the channel and choose the sub-project prototype that you want to use.
4. Once you have entered the necessary data for the sub-project, click on the Next button. The New Sub-project dialog box

shown below will appear.
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5. Choose Use Project Design File if you want to use the current drawing. If you don’t want to use the current drawing but use
a different drawing instead, select the Use New Design File option.

6. Click on the Finish button to add the project to the project listing on the Open dialog box.

7. When the Open dialog box appears, click on the subproject in the listing and click on the OK button to open the sub-project.

The RoadCalc menu will appear as shown below.
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Now that the sub-project is created, you are ready to define the alignment. You can select a line in CAD and convert it to an
alignment. You can define the alignment by entering the Pl data directly in the Edit Alignments dialog box. Additionally you can
associate an existing alignment to be the alignment to be used. In the case of a channel restoration you may use any of these three
methods to define the alignment. Below are the steps to convert a CAD object to an alignment.



CREATING THE PROPOSED ALIGNMENT

1. Select Alignments = Convert Objects to Alignment. The Convert Objects to Alignment dialog box will appear that asks
you to select the object in CAD. Select the object and accept it.

2. After you have accepted the object, you are prompted to select a point near the beginning. Pick a point near the downstream
end of the stream. You do not need to actually select the stream centerline, just near it.

3. Once the beginning of the alignment has been determined, you are prompted for stationing data. Just click on the OK button

to accept the default value of 0+00 for the BOP station.

4. At this point the stream centerline has been defined. To look at the data for the alignment, click on Alignments = Edit Data.

The Edit Alignment dialog box as shown below will appear.
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5.  After you are satisfied with the alignment data here, you can click on the Close button to dismiss the Edit Alignments dialog

box.

Now that the alignment has been defined, we are ready to define the cross-section data. You have several ways to define the cross-
sections. You can directly enter the station and elevation data in the Edit Cross-section Data dialog box. You can also extract the
cross-sections from an Eagle Point surface model or a drawing/design file. The third way is to import the cross-section data from an
ASCII file. In our example here, we will extract the cross-sections from a surface model. Obviously we will assume that you already
made the original surface model.



CREATING THE CROSS-SECTIONS

1. Select Cross-sections = Extract Cross-sections. The Build Station List dialog box below will appear as shown below.
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2. On this dialog box you can specify the station interval you want to use for extracting the cross-sections. You may want to
make sure the Stationing Interval and the curve Stations options are ON. The other options can be toggled OFF.

3. Once you have the settings the way you want, click on the OK button. The Extract Cross-sections dialog box appears as
shown below.
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On the Extract Cross-sections dialog box make sure to toggle on the Extract toggle next to the surface model you want.
Verify the corridor width you want to use. Make sure that all of the cross-sections are marked to be extracted. Remember
you can multi-select stations by holding down the Ctrl key and selecting the stations.

Once all of the options are specified on the Extract Cross-sections dialog box, click on the OK button. At this point the cross-
sections are extracted.

Now that the cross-sections are extracted, select Cross-sections = Edit Cross-section Data. The Edit Cross-section Data
dialog box will appear. Verify that the channel data looks correct.

Once you are satisfied with the cross-section data, click on the Close button to dismiss the Edit Cross-section Data dialog
box.

Now that we have defined the cross-sections along the channel, we are ready to define the proposed profile. There are two ways to
define the profile. You can graphically draw the profile in and convert it or you can directly enter the profile data in the Edit Profile

Data dialog box. In our example we will convert a line that we will draw as the profile and look at the data in the Edit Profile Data
dialog box.

CREATING THE PROPOSED PROFILE

1.
2.
3

Select Profiles = View Profile Graphics from the RoadCalc menu bar. The Profile drawing/design file will display.
In the drawing/design file draw a line representing the proposed profile of the channel.
Once the line for the proposed channel has been drawn, select Profiles = Convert Objects to Profile. A dialog box should

appear as shown below that prompts you to select the line that represents the proposed channel profile. Select the line and
accept it.
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4. Once you have selected the line and accepted it, click on the Next button on the Convert Objects to profile dialog box. The
Convert Objects to Profile dialog box will appear asking for the profile name.
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5. Make sure that Centerline is the selected profile. Click on the Finish button to convert the line to the proposed channel
profile. You will probably notice that the CAD settings for the profile line will change. The CAD settings for the profile can be
modified on the Manage Profiles dialog box.

6. Now that the profile has been converted, you can look at the data by selecting Profiles = Edit Data. The Edit Profile Data
dialog box will appear as shown below.
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7.  After you have looked at the VPI data for the profile and are satisfied, you can click on the Close button to dismiss the Edit
Profile Data dialog box.

Up to this point we have defined the proposed alignment and the proposed profile for the channel. We are now ready to draw the
typical section for the proposed channel. In our example here we will draw the bottom of the channel and then define slopes to be



used for the channel. On the typical section we create, we will be assigning PT codes to key points so that we can extract the 3D
linework from those points later. This 3D linework will be used to create the “Proposed” channel surface model. This new surface

model will be used in Water Surface Profiling later.

CREATING THE TYPICAL SECTION

1. Before we can draw the typical section, we need to specify the name of the proposed channel surface. Select Cross-
sections 2 Manage Surfaces. The Manage Surfaces dialog box will appear as shown below.
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2. Select the Design tab on the dialog box. You'll notice that the listing is blank. Click on the New Surface icon in the lower
left-hand corner of the dialog box. The New Design Surface dialog box should appear as shown below.
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Section dialog box will appear as shown below.

On the New Design Surface dialog box enter a name for the channel surface. You may want to use Channel as an example.
After the name has been entered, click on the OK button to save the name and close the New Design Surface Dialog box.
Click on the Close button on the Manage Surfaces dialog box to dismiss the dialog box.

Now we are ready to draw the typical section. Select Typical Sections - Manage Typical Sections. The Manage Typical
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Manage Typical Sections: 002 - Stream Restoration for FFFES
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Click on the New Typical Section button in the lower-left corner of the dialog box. The New Typical Section dialog box as
shown below appears.
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On the New Typical Section dialog box enter a name for the typical section. You might want to use Channel, for example.
There is another area on this dialog box to enter an extended description if you want.

After you have entered the name, click on the OK button to save the name and close the New Typical Section dialog box.
Now we are ready to draw the typical. On the Manage Typical Sections dialog box, click on the binocular icon in the lower
left corner of the dialog box. The typical section drawing/design file will be displayed.

Click on the Close button on the Manage Typical Sections dialog box to dismiss the dialog box.

Now select Typical Sections = Construct Typical Section. The construct Typical Section dialog box should appear as
shown below.
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Click on the Cut and Fill Details button (the third icon from the left) to make sure that we are editing in both views.

We are going to draw the lines representing the bottom of the channel now. Click on the Precision Input button (the

second icon from the left). The Construct Typical Section dialog box will update so you can enter the points along the typical

section.

You will notice that the Start Point edit field is enabled. The strings of text above the edit field are there to help you to know

what to key in when entering the data. If you type “A”, that means you want to enter an absolute coordinate. If you type “XS”,

that means you want to enter a point a delta x value from the last point at a certain percent slope. In the edit field type a and

select the Enter key on your keyboard. You should be prompted to enter the “X” value. Key in 0. Select the Enter key.
Microstation Users: Make sure you select the Place Smartline command in Microstation before you enter the X and Y
values for the typical section.

At this point you should be prompted to enter the “Y” value. Enter O again and Select the Enter key on the keyboard.

At this point you are asked for the PT code. This is just an identifier for the point that we will use later to extract the 3D lines

into the plan drawing. For the PT code enter 1. Select the Enter key on the keyboard.

You should now be prompted to enter a new location with “a” appearing in the edit field. RoadCalc remembers what you last

used for entry and prompts to use the same entry option again. This time we are going to use “XS” to specify one side of the

channel. Type XS in the edit field and select the Enter key on the keyboard.

You are now prompted for the Delta X value. Enter the value you want for one side of the channel. We are entering only one

side of the channel in this example because we will be mirroring the typical section. After entering the value select the Enter

key on the keyboard.

Now you are prompted for the % Slope value in the edit field. Enter O for a flat bottom channel. Select the Enter key.

At this time you are prompted for the PT Code. Enter a value of 5 or larger. The PT Code values of 1, 2, 3, and 4 are

reserved for special uses. The PT Code of 1 is used for the centerline, which we already assigned. Select the Enter key

after you have entered the PT Code.

We are finished drawing the bottom of the channel for one side of the channel. Type X in the edit field and select the Enter

key on the keyboard. This specifies that we are finished entering linework for the typical section.

We are ready to mirror the typical section from the right to the left. Select the Mirror Typical Section from Right to Left

button. The typical section should be mirrored so that both sides of the typical section is shown now.

Now we need to define the typical section. Click on the Define Typical Section button (the third button from the right). The

Define Typical Section dialog box will appear as shown below.
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Make sure the surface is selected in the listing and click on the Define button. The typical section will get defined and the
Define Typical Section dialog box will be dismissed.




26.

Note: If you have more than one surface, you will select the surface, then select the Define button. At this point you would
pick inside the boundary of the surface. This would repeat until all surfaces have been defined. See the RoadCalc
documentation for more information.

Now that the typical section has been defined, click on the Close button on the Construct Typical Section dialog box to
dismiss it.

We have up to this point created the typical section. We now need to define the slopes that are to used for the channel and where to
use the typical section. We will be using some of the commands under the Process menu in RoadCalc.

PROCESSING THE TYPICAL SECTION

1.

2.

To enter the slopes, all you need to do is select the Process = Slopes Library command. The Slopes Library dialog box
will appear as shown below. This dialog box will display all of the allowable slopes you can use. If you expand the Single
Slope tree view out, you can see the available single slopes. To add a new slope you would select the New Slope button. If
you like the slopes that are available, click on the OK button.
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We need to now define a Condition Table in RoadCalc. The condition table allows you to specify what slopes to use for
certain conditions. We will be using a 3:1 slope always in our example. Select Process = Manage Condition Tables. The
Manage Condition Tables dialog box will appear as shown below.
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3. Select the New Condition Table icon in the lower left corner of the dialog box. The New Condition Table dialog box as
shown below will appear.
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4. Enter a Name for the condition to be added. For our example you may want to enter “Slopes”. As you can see from the
dialog box, you can specify different slopes based on different depths of cut and fill. By default, the Single 3:1 H/V slope is
displayed in the condition table.

5.  We are going to accept the default setting for this example, click on the OK button to save the condition table. The New
Condition Table dialog box will be dismissed.

6. You should now see the description you entered for the condition table in the Manage Condition Tables dialog box. Click on
the Close button to dismiss the dialog box.

7. Now we will specify the locations where we want to apply the typical section and the condition table. Click on Process 2>
Edit Design Locations. The Edit Design Locations dialog box will appear as displayed below.
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8. We will define the Typical Section Locations first. Click on the New Typical Section Location button. The New Typical
Section Location dialog box will appear.
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9. Enter O for the Station value. Leave the Typical Section and Transition Type settings alone. Click on the OK button to save
the value and dismiss the dialog box.
10. Click on the New Condition Table Location icon. The New Condition Table Location dialog box will appear as shown below.
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11. Enter O for the Station value. The Left Condition Table and the Right Condition Table will be set to the condition table name
you entered earlier. Click on the OK button to save the locations.

12. You should now see that both the Typical Section location and the Condition Table Location use 0+00 for the starting value.
You do not need to enter a ending value if you want to process the same typical and condition through the entire project.
Click on the Close button to dismiss the Edit Design Locations dialog box.

13. We are now ready to Run Design and process the proposed channel through the project. Select Process = Run Design.
The Run Design dialog box below will appear.
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14. The Starting and Ending Stations should display the values for the project by default. Leave the toggle on Use Design
Locations. You can also leave the Method set to Automatic.

15. Click on the Run button. The typical section will be processed through the project using the proposed channel alignment and
profile. If you get processing errors, look at the stations where the errors occurred and fix them.

Now that we have processed the channel through the project, we are now ready to extract the 3D geometry of the channel to the
Plan drawing/design file. The linework that gets extracted will extracted from the points on the typical section that had a PT code
assigned.



EXTRACTING THE 3-D LINEWORK

1. From the Output menu in RoadCalc select Breaklines from PT Codes. The Breaklines from PT Codes dialog box will
appear as shown below.
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2. What we need to do now is place a check next to the PT codes that we have on the channel and select the surface to
extract. Scroll down to PT Code 1 and place a check so it is extracted. Change the surface so that it is set like shown below.
If you had a different description for the design surface you added, that's OK. Just make sure the design surface is selected.
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3.  Now let's set the next PT Code to be extracted. Scroll down to PT Code 5 (or the one you used when you defined the edge
of the channel in Typical Sections). Place a check in the Extract column next to PT Code 5. Make sure that you select the
design surface for the PT Code, just like in step 2 above.



4. Leave the Use Station Range and Place at Elevation Zero toggles OFF. Click on the CAD Settings icon. The CAD Settings

dialog box will appear as shown below.
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5. Enter the CAD Settings you want for the breaklines that will be drawn. Click on the OK button on the CAD Settings dialog
box to save the settings and dismiss the dialog box.
6. Click on the OK button on the Breaklines from PT Codes dialog box. The 3D lines will be extracted for the bottom of the

channel.

7. Now we will extract the catchpoints of the slopes from the channel. Select the Output - Catchlines command. The
Catchlines dialog box will appear as shown below.
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8. Leave all of the toggles in the state they are shown above. Click on the CAD Settings icon. The CAD Settings dialog box will

display.

9. Set the CAD Settings the way you want. Once you have the cad settings the way you want them, click on the OK button on
the CAD Settings dialog box to save the settings and dismiss the dialog box.
10. Click on the OK button on the Catchlines dialog box to extract the catchlines.

USING SURFACE MODELING TO CREATE THE PROPOSED SURFACE

We now have the 3D linework that we need to make the “Proposed” surface model. At this point you can close RoadCalc if you
want. We won'’t need to use that model for this example anymore. We will now be using Surface Modeling to create a surface model
of this proposed channel. Once the channel is created we will merge the proposed channel into the original ground surface model.
This will create the “As Built” surface model that we will use in Water Surface Profiling.

1. From the Eagle Point menu bar select Products - Surface Modeling. The Surface Modeling menu bar will appear as shown

below.
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3.

What we need to do is now define the name for the surface model. We will define a nhame for the “Proposed” model and
another for the “As-Built” model. Select Prepare - Manage Surface Models from the Surface Modeling menu bar. The
Manage Surface Models dialog box will appear as shown below.
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You may see one or more models in this listing already. Click on the New Surface Model icon (the first icon from the left).
The New Surface Model dialog box will appear as shown below.
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For the Description, enter Proposed Channel. Enter appropriate values for the Minimum and Maximum Valid Elevations.
Click on the OK button to save the surface model names to Manage Surface Models dialog box and dismiss the New
Surface Model dialog box.

The Manage Surface Models dialog box should now have Proposed Channel displayed in the listing. Click on the New
Surface Model icon again.

When the New Surface Model dialog box appears again, enter As-Built Channel in the Description edit field. Set the
Minimum and Maximum Valid Elevations to appropriate values.

Click on the OK button on the New Surface Model dialog box to add the As-Built Channel surface to the Manage Surface
Models dialog box.

Click on the Close button on the Manage Surface Models dialog box to dismiss it.




10. We are now ready to make the surface model for the Proposed Channel surface. If you are in Microstation, place a Fence
around the lines that you want to make a surface model of.
11. Select the Triangulate = Surface Model command. The Triangulate Surface Model dialog box appears as shown below.
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12. Make sure that Proposed Channel is selected as the Surface Model. For the Boundary option, pick Select. We will be
drawing a boundary around the lines we want to use for the proposed surface model.

13. To place a boundary around the line, use the Microstation Shape tool. Draw an irregular shape around all of the lines so that
we don't get triangles jumping across areas with no data. If you are using AutoCAD, use the polyline command and make
sure it is closed.

14. Once the boundary is placed, click on the Apply button on the Triangulate Surface Model dialog box. You will be prompted
to select the Boundary. If you are using AutoCAD, you will be prompted to select objects first, then the boundary. Select the
boundary and accept the selection. The surface model should be created.

15. Click on the Close button on the Triangulate Surface Model dialog box to dismiss the dialog box.

Now that the Proposed Channel surface model is created, we are now going to create the As-Built surface model. To create the As-
Built surface model we are going to use the Merge Surface Models command in Surface Modeling.

MERGING THE SURFACE MODELS

1. Select Triangulate & Merged Surface Models. The Merged Surface Models dialog box as shown below will appear.
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[ User-defined Boundary [ Dizplay Maodel

Apply I Cloze |

2. Set all of the settings as shown in the figure above. Click on the Apply button and the As-Built surface model will be created
from the Original Ground and Proposed Channel surface models.

3. After the surface model is created, click on the Close button on the Triangulate Merged Surface Models dialog box to
dismiss it.

USING WATER SURFACE PROFILING

Now that the As-Built Channel surface model is created, we can now use Water Surface Profiling to take this information into HEC-
RAS to calculate the flows and model the channel.



1. The first thing we need to do is start a new Water Surface Profiling sub-project. To do that select the File > New command
from the Eagle Point menu bar. The New dialog box will appear as shown below.

New &[]
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2. Highlight Water Surface Profiling Sub-project in the listing and click on the Next button.
3. The Water Surface Profiling Sub-project dialog box should now display. Accept the default Sub-Project nhumber that is
displayed. Enter in a Description for the sub-project. Verify the Units droplist is set to the correct units.

Wwater Surface Profiling Sub-project EE
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4. Once the description has been entered for the sub-project click on the Next button. The New Sub-project dialog box will
appear.

5. Make sure that the Use Project Design File option is selected. Click on the Finish button.

6. At this point the Open dialog box will appear. Be sure to highlight the new sub-project you just added. The Water Surface
profiling sub-projects have a purple icon associated with them. See the figure below.
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7. Click on the OK button to open the sub-project. Notice that the Water Surface Profiling menu bar will appear as shown
below.

“Water Surface Profiling 002 : ... NS E3

glignmentz  Crosz-Sections  Tranzfer  Qutput

B EEEEE

We are now ready to define the alignment for the proposed channel in Water Surface Profiling. Since we have already created the
alignment in RoadCalc, all we will need to do is associate the alignment.

ASSOCIATING THE CHANNEL ALIGNMENT

1. Select Alignments = Manage. The Manage Alignments dialog box will appear.

2. Click on the Associate Alignment button on the Manage Alignments dialog box. The Associate Alignment dialog box will
appear as shown below.

3. Highlight the Centerline from the RoadCalc project we created earlier. After that is done click on the OK button. An Eagle
Point message dialog box will appear asking you to associate directly or to make a copy. Click No so that we make a copy of
the alignment.

Eagle Point

Y'ou may aszociate the alignment directly or make a copy.
Wiould you like ho azsociate the alignment directy?




4.

The Manage Alignments dialog box should now show the Stream Alignment with a Design File path to the right of it. This

means the alignment is defined. Click on the Close button to dismiss the Manage Alignments dialog box.

Now we are ready to define the cross-section locations for the channel. You can create Fixed Cross-sections where you draw the
alignment of each cross-section or you can extract the cross-sections at some set interval. In our example we will draw in the cross-
sections we need in the CAD graphic and convert them.

CREATING THE CROSS_SECTION ALIGNMENTS

1.

2.

The first step to create the cross-sections is to draw the cross-section lines in the drawing/design file. Below is an example
of what these lines may look like. If you are in Microstation, you can use the Place Smartline command to create the lines. In
AutoCAD you can use the polyline command to create the lines.

Once the lines are drawn, you need to add the cross-section names to the Manage Alignments dialog box. Click on
Alignments - Manage. The Manage Alignments dialog box will appear. Click on the New Cross-section Alignment icon. The
New Cross-section Alignment dialog box will appear as shown below.

Mew Croze-Section Alignment
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k. I Cancel

For the first cross-section Alignment Name you can enter a description that is helpful. For the sake of this exercise let's enter
Fixed Xsec 1 in the edit field. Leave the Station along Stream Alignment edit field alone. Water Surface Profiling will
automatically calculate value based on the stream alignment when the line is converted.

Click on the OK button on the New Cross-section Alignment dialog box. The Fixed Xsec 1 description is added to the
Manage Alignments dialog box.

Repeat steps 3 and 4 above to add all of the Cross-section Alignment names necessary to the Manage Alignments dialog
box.

Once all of the cross-section alignment descriptions have been added, click on the Close button on the Manage Alignments
dialog box to dismiss the dialog box.

Now we are ready to convert the lines drawn into cross-section alignments. Select the Alignments - Convert Objects to
Cross-Section Alignment command. The Convert Objects to Cross-section dialog box will appear prompting you to select
the cross-section line. Pick the most downstream cross-section first and accept it. Be sure to follow the prompts at the
command line or status bar in CAD.




Convert Objects To Crogs-Section Alignment: 003 - Proposed Eharﬁﬂ

Select the objects pou wizh to convert to an alignment.

8.  After you have accepted the cross-section, the Convert Objects to Cross-section Alignment dialog box will appear as shown
below. Make sure that Fixed Xsec 1 is the Alignment selected. Leave the Station Along Stream Alignment value alone.
Toggle ON the Extract Elevations from Surface Model option and select As-Built Channel as the Surface Model.
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9. Click on the Apply button to convert the cross-section line to a cross-section alignment. At this point the cross-section line is
converted to a cross-section alignment and the elevation data for the cross-section is extracted from the surface model.

10. Repeat steps 7, 8, and 9 for the remainder of the cross-sections. Make sure you choose the correct cross-section Alignment
for each line that is being converted.

At this point we have defined all of the cross-sections for the channel. If you want to look at the data you can do so by selecting the
Edit Data command from Cross-sections menu in Water Surface Profiling.

We are now ready to take the proposed alignment and cross-section data to HEC-RAS.
EXPORTING THE GEOMETRY DATA TO HEC-RAS

1. To export the data to HEC-RAS select Transfer > Export to HEC-RAS. The Export to HEC-RAS dialog box will appear as
shown below.
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2. Inthe File edit field, you can accept the default for the file name or enter in a different path. You need to make sure that .geo
is the file extension.

Set the Export Precision for the different settings to what is shown in the figure above.

Click on the OK button to export the data to the file specified.

At this point the HEC-RAS Export Complete dialog box will appear. Click on the Run HEC-RAS button and close the HEC-
RAS Export Complete dialog box.

S

At this point we are now going to use HEC-RAS to import the geometry data we exported out of Eagle Point. The first thing we will
do is start a new project in HEC-RAS. After this is done we will import the geometry file. Once this is done, you will be able to model
culverts, bridges and etc.

IMPORTING THE GEOMETRY FILE INTO HEC-RAS

1. Onthe HEC-RAS dialog box, select File > New Project. The New Project dialog box will appear as shown below.
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2. Enter a title for the project in HEC-RAS. You need to specify the File Name as well. Make sure to keep the .prj extension.
For our example enter Proposed Channel for the Title and Proposed.prj for the filename.

3. For the Directory, make sure you select the directory where you want the HEC-RAS files to go. DO NOT put the files into the
directory where your Eagle Point project files are located. You could inadvertently overwrite project critical files.

4.  Click on the OK button on the New Project dialog box in HEC-RAS. The project is added and you are asked if you want to
create a new project. Click on OK.

5. Now that the project has been added you might want to make sure you are using the correct units. If you need to change the
project units in HEC-RAS, select Options = Unit System on the HEC-RAS dialog box. The dialog box will appear as shown
below.
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6. Select the units you want to use and then click on the OK button to save the setting.
7. Now select Edit > Geometric Data from the HEC-RAS dialog box. The Geometric Data dialog box will appear as shown
below.
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8. Select File © Import Geometry Data = GIS Format. The Import GIS Format dialog box will appear.

Import #GIS Format data file

Title File Name Directaries
I# HEC-RAS Input file generated by Eagle |1 F4r277003.ge0 dACOMMDOT Project

# HEC-RAS Input file generated by E agle 174r277001.ge0 S
it HE C-HAS Input file generated by 3 ERCONNDOT

[ Conn DAT Train 2
[ HECRAS
[ prevep

k. Cancel Help Create Directany I = d: [Jon's Data) j

|Select GIS Format file to impart




9. On this dialog box select the .geo file that was created earlier by Water Surface Profiling. Once you select the file you should
see a description appear in the Import GIS Format dialog box that says something like “# HEC-RAS Input File Generated by

Eagle Point”.
10. Highlight the file in the listing and click on the OK button. The geometry should be imported into the Geometric Data dialog
box.

At this point you can work with the data and enter additional geometry information as well as flow data. Once you have completed
the modeling in HEC-RAS, you can create Water Surface Profiles and Delineate Flood Plains in Water Surface Profiling.

If you have additional questions related to the modules described here, please refer to the documentation for the individual modules
or call technical support.
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